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Overview

Introductions

• Who are you?

• What’s your background?

• What kind of machine?

• Instructions are optimized for Windows 2000/XP

XML Workstation Overview

• Workstation vs server optimization

• Command line and GUI

• API and programming

• Origins of this “configuration”

• Mulberry / SunU

• aXtive Minds / HP

• The tools on the CD were chose for general “coolness”

• I emphasized tools that were not vendor demos and/or timed out

Configuration Overview

• Options

• Install tools to “natural” directories

• Install tools to engineered hierarchy

• Install subset of tool files to engineered directory (XTools)

• Approach

• Start with XTools, but provide full installation files, as appropriate

• Install tools to “natural” directories, as needed

• Use batch files to encapsulate and document command lines

Roadmap

• Install Java Platform

• Install Microsoft Platform

• Internet Explorer 6

• MS XML 4

• Microsoft IE Tools for Validating XML and Viewing XSLT Output

• Install and configure the XTools directory

• Install an editor

• Install other tools, as time allows

A Few Places To Go To Look For Tools

• xmlsoftware.com

• www.garshol.priv.no/download/xmltools/ free xml tools

• www.vbxml.com/

• staff.develop.com/aarons/xmllinks.htm

• webattack.com
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Java Platform

Also Known As

• Java virtual machine

• Java runtime engine

• Java developers kit

• Java 2 platform

Role

• Operating system-independent software platform and programming environment

• Some tools delivered as “complete” java applications

• Some tools delivered as .jar files

Issues

Dependencies

• Operating system

• Administrative permissions

Alternatives

• 1.3 vs 1.4

• JRE vs JDK/SDK

Potential Problems

Performance

Conflicting Java versions

• Uninstall previous versions

• Use Sun distributions

• Install in order

Classpath

• Must reference individual .jar files

• Control points

• System environment

• Control Panel -> System -> Advanced -> Environment Variables

• Edit CLASSPATH variable

• Win 9x Autoexec.bat

• Special DOS box that initializes Classpath

• Win2k hack to initialize every DOS box

• Batch file style

• Articulate individual .jar files

• Iterate across all .jar files in a directory
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Installation

Where to get it

• java.sun.com/j2se/1.4.1/download.html

• cd:\Java\

Provided versions and files

Java 2 Platform Standard Edition 1.3.1_01 (windows, all languages)

• j2re-1_3_1_01a-win.exe

• j2sdk-1_3_1-doc.zip

• j2sdk-1_3_1-win.exe

• j2sdk-1_3_1_01-win.exe

Java 2 Platform Standard Edition 1.4.1_01 (windows, all languages)

• j2re-1_4_1_01-windows-i586-i.exe

• j2sdk-1_4_1-doc.zip

• j2sdk-1_4_1_01-windows-i586.exe

Additional 1.4 documentation

• JavaDownload.pdf

• JavaInstall.pdf

• JavaReadMe.pdf

Installation Procedure

1. Double-click and follow prompts

2. Custom installation lets you change directories

What it puts on your computer

Files

• C:\Program Files\Java\j2re1.4.1_01\*.*

• SDK -> C:\jdk\*.*

• 1.3 -> C:\Program Files\JavaSoft\JRE\*.*

Integrations

• Microsoft Internet Explorer

Shortcuts

• Java Web Start on Desktop and under Programs

Testing

1. Entering “java -version” on the command line should return:

java version "1.4.1_01"

Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.1_01-b01)

Java HotSpot(TM) Client VM (build 1.4.1_01-b01, mixed mode)
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Microsoft Platform

Role

• Provides basic XML parsing and XSLT processing

• Provides SDK documentation interface

• Allows XML documents to be validated within Internet Explorer

• Allows XSLT output to be viewed from within Internet Explorer

Internet Explorer

Role

• Provides rendering of XML and HTML files

• Supports “on-the-fly” XSLT to HTML transformations

• Displays XML files using dynamic HTML expandable and collapsible trees

• Can display DTD code

Issues

Dependencies

• Microsoft Windows

Alternatives

Netscape 8

• Reports of good XSLT support

Opera

• Very fast

• Excellent handling of book marks

• Excellent navigation (right-click drag for forward and backward)

• Excellent downloading interface

• Terrible XML support

• Only supports CSS

• Requires a CSS stylesheet for any acceptable level of rendering

• Relatively weak formatting and electronic forms support (DOM-based processing)

Potential Problems

• Earlier versions (MSIE 5, MSIE 5.5, MSXML 3, etc.) implemented a non-standard

version of XSLT

• Most reliable platform is MSIE 6 – MSXML 4 combination
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Installation

Where to get it

• cd:\MSIE6\

• Can download small setup from www.microsoft.com/windows/ie/ which dynamically

downloads and installs modules

• Can order a CD

• Can use a recent Earthlink CD

Installation Procedure

1. Double click on \MSIE6\ie6setup.exe

2. Follow onscreen prompts

MS XML 4.0

Also Known As

• Microsoft XML Core Services

Role

• Provides basic parsing and processing toolkit

• Provides an electronic SDK document

Issues

Dependencies

• Only works reliably with Internet Explorer 6.0

• Requires Windows Installer 2.0

(www.microsoft.com/downloads/release.asp?releaseid=32832) 

Strengths

• Underlying parser is very fast

• Tightly integrated with Internet Explorer

• Excellent prototyping environment

• May also be used from the command line

Weaknesses

• Error messages are somewhat non-descriptive

Potential Problems

• Earlier versions uses non-standard XSLT namespace and syntax

• In most cases, can install cleanly on top of any other copies of MSXML. Individuals who

installed beta copies may need to uninstall them before installing MSXML 4
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Installation

Where to get it

• www.microsoft.com/downloads/  Search for “xml core services”

• www.microsoft.com/downloads/release.asp?ReleaseID=37176

• cd:\MSXML4\

Provided files

• cd:\MSXML4\

• msxml.msi

• MSXML4.pdf

Installation Procedure

1. Right-click on the msxml.msi file and select Install

2. Follow onscreen prompts

What it puts on your computer

Files

• C:\WINNT\system32\msxml4.dll

• C:\WINNT\system32\msxml4r.dll

• Perhaps some other files (e.g., electronic documentation)

Integrations

• Most notably, Internet Explorer 6

Shortcuts

• Microsoft XML 4.0 Parser SDK

Testing

1. Open cd:\XTools\Installs\MSXMLTest.htm in Internet Explorer

2. Verify that "Msxml2.DOMDocument.4.0" is checked

3. Invoke the "Microsoft XML 4.0 Parser SDK" shortcut under Programs

4. Verify that it brings up the "Microsoft XML Core Services (MSXML) 4.0" help system

Microsoft IE Tools for Validating XML and Viewing XSLT Output

Role

• Provides a very convenient set of context menu options in Internet Explorer

• Validate XML

• View XSL Output

• Without these options, Internet Explorer will only

• Notify you if an XML document isn’t well-formed

• Allow you to view the raw XML source (via the “View Source” option)
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Dependencies

• This has only been tested with MSIE 6 and MSXML 4

Installation

Where to get it

• msdn.microsoft.com/msdn-files/027/000/543/search.asp

• cd:\MSIEViewerTools\

Provided files

• cd:\MSIEViewerTools\

• iexmltls.exe (the distribution file)

• IEXMLTLS\*.* (expanded file set)

Installation Procedure

Note: This is a two step procedure

1. Execute iexmltls.exe to decompress installation files (nominally to C:\IEXMLTLS)

2. Install the utilities

a. Navigate to the directory containing the decompressed files

b. Right-click on msxmlval.inf file.  Choose the Install option.

c. Right-click on msxmlvw.inf file.  Choose the Install option.

3. The C:\IEXMLTLS directory may be deleted after installation

Alternative Installation Procedure

1. Navigate to cd:\MSIEViewerTools\IEXMLTLS\

2. Install the utilities

a. Navigate to the directory containing the decompressed files

b. Right-click on msxmlval.inf file.  Choose the Install option.

c. Right-click on msxmlvw.inf file.  Choose the Install option.

What it puts on your computer

Files

•  C:\IEXMLTLS\*.*

Integrations

• Adds two options to the Internet Explorer context menu (accessed by right-clicking within

the browser)

• Validate XML

• View XSL Output

Testing

1. Open Internet Explorer

2. Right-click in the browser window

3. Verify the existence of the “Validate XML” and “View XSL Output” options
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XTools

Role

• Provides a basic package of parsers, XSLT processors, and command line interfaces

Issues

Dependencies

• Some of the tools require a Java engine

• Some of the tools require the MS XML 4.0 parser

• Requires classpath environment variable to be updated

• Requires path to be updated

Strengths

• Relatively quick and easy installation

• The configuration has been stable for over 9 months

Weaknesses

• Static toolkit

Potential Problems

• Depending on path and classpath settings, may conflict with full installations

Installation

Where to get it

• Unique to this distribution.  Many of the files can be downloaded as part of their

respective distributions.

• cd:\XTools\

Provided files (see respective sections in this document)

Saxon 6.5.1 XSLT processor

• jsaxon.bat

• saxon-fop.jar

• saxon-jdom.jar

• saxon.exe

• saxon.html

• saxon.jar

XT XSLT processor

• xp.jar

• xt.bat

• xt.jar
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Sun parser

• parsevalid.bat

• parsewf.bat

• xml.jar

• xmlclass.jar

MS XML 4.0 interfaces

• msxsl.exe

• validate.bat

• validate.js

• wellformed.bat

• wellformed.js

Installation Procedure

1. Copy cd:\XTools\*.* to C:\XTools

Configuration

1. Integrate via path and classpath 

Testing

Testing procedures are included in the Set Path and Classpath section

Set Path and Classpath

Role

• Locate java classes

• Locate executables and scripts

Issues

Dependencies

• Requires installation of various tools and libraries

Alternatives

Set in Windows environment

• Relatively straightforward

• Has to be updated with introduction of new tools

• May be overwritten by software installations

Create a custom command prompt shortcut

• Can be maintained and updated using batch code

• Works cleanly with the system environment

• Easy to implement

• Only works for the customize command line
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Use AutoRun

• Can be maintained and updated using batch code

• Layers cleanly with the system environment

• Applies to all invocations of the command processor

• Relatively difficult to implement (requires change to registry)

Installation

Provided files

cd:\Configuration\AutoRun and cd:\XTools

• ClassPath.cmd

• InitCommandComplex.cmd

• InitCommandSimple.cmd

cd:\TestFiles

• Bizcards.xml

• bizcards.xsd

• memo.dtd

• memo.xsl

• NotWellFormedMemo.xml

• ValidMemo.xml

Configuration Procedure

Set in Windows environment

1. Start -> Settings -> Control Panel -> System -> Advanced -> Environment Variables ->

CLASSPATH

2. Enter the full path and filename for each .jar file

Create a custom command prompt shortcut

1. Create a shortcut to c:\WINDOWS\system32\cmd.exe

2. Right-click on the shortcut and select Properties

3. Add the batch file to the “Target” field using the /k switch

a. C:\WINDOWS\system32\cmd.exe /k c:\XTools\InitCommandSimple.cmd

4. Specify a default directory using the “Start in” field

5. Set font and window size, as desired

Use AutoRun

1. Create C:\AutoRun.cmd

a. A sample set of files is included

i. InitCommandSimple.cmd sets path and classpath directly

ii. InitCommandComplex.cmd only sets path.

(1) Classpath is set through a separate, iterating ClassPath.cmd file.

(2) ClassPath.cmd is configured by specifying the directories that contain the .jar

files.  Each .jar file does not need to be listed, separately.

2. Run regedit.exe

Page 10 Setting up an XML Workstation

© 2002 The Sagebrush Group SagebrushGroup.com (408) 247-0454



3. Highight HKEY_LOCAL_MACHINE

a. Windows2000

i. Search for “command.processor” [verify this string]

ii. Verify that at HKEY_LOCAL_MACHINE/SOFTWARE/Microsoft/Command

Processor

b. WindowsXP

i. Search for “Command Processor”

ii. Verify that at  HKEY_LOCAL_MACHINE/SOFTWARE/Microsoft/Command

Processor

iii. Change AutoRun (type REG_SZ) to “c:\AutoRun.cmd”Configuration

What it puts on your computer

Files

• Depends on the configuration method chosen

Integrations

• Provides ability to run command line tools from a command processor

Shortcuts

• If the Create a custom command prompt shortcut option is chosen, a command prompt

shortcut is created

Testing

1. Invoking "saxon" on the command line should return the following message:
No source file name

SAXON 6.5.1 from Michael Kay

Usage: saxon [options] source-doc style-doc {param=value}...

...

2. Invoking "jsaxon" on the command line should return the following:
C:\>java  com.icl.saxon.StyleSheet

No source file name

SAXON 6.5.1 from Michael Kay

Usage:  java com.icl.saxon.StyleSheet [options] source-doc style-doc {param=value}...

...

3. Invoking "parsewf" at the DOS prompt should return the following:
C:\>java parsewf

Usage: cmd filename

4. Invoking "validate" at the DOS prompt should return the following:
C:\>cscript c:\XTools\validate.js

Microsoft (R) Windows Script Host Version 5.6

Copyright (C) Microsoft Corporation 1996-2001. All rights reserved.

usage: validate filename

5. Alternatively, test may be performed using the files in cd:\TestFiles
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DOS Prompt Here

Role

• Adds a “DOS Prompt Here” option to the context menu in Windows Explorer

• Allows you to open a command processor already set to the desired directory

• Really, really handy for running command-line tools

Issues

• Requires changes to the Windows registry

• The instructions provided here are dependent on the AnalogX X-Setup tool

Installation

Where to get it

• Information on the registry hack can be found at

www.vb2themax.com/Item.asp?PageID=TipBank&Cat=1400&ID=199

• X-Setup can be found at

• www.xteq.com/

• www.xteq.com/products/xset/index.html

• cd:\Configuration\AnalogX\XSetup\

Provided versions and files

X-Setup version 5.7

• xqxset57.zip

• XSetupIndex.html

X-Setup version 6 Beta

• V6Beta

X-Setup version 6.1 (recommended)

• xq-xsetup61.zip

• V61UnZipped\*.*

Additional files in cd:\Configuration\AnalogX\XSetup\

• MSConfig.PDF (article on using msconfig to speed up startup

• Startup Manager Utlility

• StartupManager.PDF

• strtupst.exe

Additional files in cd:\Configuration\AnalogX\

• Various other utilities from AnalogX

• Most include .pdf files of relevant web pages

Installation Procedure

1. Run cd:\Config\AnalogX\XSetup\V61UnZipped\setup.exe

2. Follow onscreen prompts

Page 12 Setting up an XML Workstation

© 2002 The Sagebrush Group SagebrushGroup.com (408) 247-0454



What it puts on your computer

Files

• C:\Program Files\X-Setup\*.*

Shortcuts

• “Xteq Systems X-Setup” under Start/Programs

Configuration

1. Start X-Setup

2. Choose the X-Setup tab

3. Press “Launch X-Setup Default UI”

4. Either

a. Traverse the tree to the customization panel:

Appearance > Files & Folders > Drives > DOS prompt here

b. Search for “dos prompt” and click on the “DOS prompt here” line

5. Activate the option for both directories and driver root.

6. Press “Apply Changes (F9)”

7. Exit X-Setup

Testing

1. Open Windows Explorer

2. Right clicking on c:\ should display an option titled: “DOS Prompt Here”

3. Right clicking on c:\XML101 should display an option titled: “DOS Prompt Here”

Windows Explorer Settings

Role

• Tunes Windows Explorer settings for ease of use

Configuration Procedure

1. Create a Windows Explorer shortcut on the Desktop.  Double-click to test.

2. Deactive "Web content in folders"

a. Tools > Folder Options > Web View

b. Click on "Use Windows classic folders"

3. Show Detailed view

a. View > Details

4. Active Attribute column

a. View > Choose Columns

b. Verify that Attributes box is checked

5. Display file extensions

a. Tools > Folder Options

b. Verify that "Hide file extensions for known file types" box is unchecked

6. Adjust column sizes, as appropriate

7. Propagate settings to all folders

a. Tools > Folder Options

b. Click on "Like Current Folder"

Editors
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Role

• Provide ability to view, update, and create various XML files

• Editors tend to vary primarily along two dimensions

• XML-awareness

• Treats XML as text (no awareness)

• Can be taught some basic syntax rules to support syntax highlighting

• Understands XML syntax

• Understands and can validate documents to a DTD or schema

• Visual sophistication

• Plain text interface

• Multi-colored interface

• Ability to associate XML structures with a stylesheet (typically CSS or custom)

• Provide various/multiple views of the XML

• Tree

• Markup

• Iconized Markup

• Formatted rendering with or without markup

• Many editors contain a mixture of features across both dimensions

• The editors on this list were ones that caught my eye because of their feature set

Where to get one

• A very comprehensive list of editors can be found at www.nokiko.com/xml/links.asp?ID=4

• Also see www.cs.uu.nl/research/projects/proxima/XMLEditorsOverview.html for a list of

editors

• I have found very interesting XML-aware editors at some of the traditional HTML/web-tool

sites.

Dependencies

• Most of the available editors require Windows.  A few run on MacOS and some Java-based

XML editors are starting to appear.

Alternatives on the CD

Abidos XML Editor

• An HTML/XML editor that does data extraction (via the WebClipping module)

• cd:\Editors\Abidos\

Context

• Free programmer’s editor with syntax highlighing

• Not sure why it caught my eye

• cd\Editors\Context\
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Cooktop

• A free XML editor with a nice set of features

• I tested an earlier version under WindwsME and it didn’t run well

• This version seems a lot more solid

• cd:\Editors\Cooktop\

EditPlus version 2.11

• After doing a fairly extensive search for a programmer’s editor, I settled on this one and

use it regularly

• Doesn’t get in the way.

• Handles multiple files nicely

• Nag-ware:  Doesn’t time out but tells you at startup how many days over 30 you are

• Syntax highlighting is adequate but not really intelligent (especially around quotes /

attributes

• I wish it had a macro capability

• cd:\Editors\EditPlus\

• cd:\Editors\EditPlus\XMLFiles\ contains my current syntax, cliptext, and template files

EkSmile

• Very interesting editor with XSchema support

• Java-based (delivered as a .jar file)

• cd:\Editors\EkSmile\

Elf

• A validating XML editor for Mac (OSX and Classic)

• cd:\Editors\Mac\Elf\

HTMLKit

• A very full-featured HTML editor that has an XML validator plug-in

• Free version

• Enters matched start/end-tag pairs

• There’s a stray Saxon document in this directory

• cd:\Editors\HTMLKit\

Jaxe

• A Java-based XML editor with a fairly innovative way to display structures

• cd:\Editors\Jaxe\

Jext

• A Java-based programmer’s editor with XML syntax highlighting

• Uses JRE 1.4

• Have had it installed on my system for quite some time, but haven’t done much with it

• www.jext.org/home.html

• cd:\Editors\Jext\
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MSXMLNotepad

• One of the classic XML “tree-editors” that puts the XML structure in a panel on the left

and shows the value of individual nodes on the right.

• When my 9 year-old son tested it.  He preferred a text editor.

• cd:\Editors\MSXMLNotepad\

OpenOffice

• A free version of Sun’s StarOffice

• This version is relatively old (2002.01)

• Uses an XML-based file format (see openoffice.org for the DTDs)

• XML files are stored in a zipped format and can be unzipped and manipulated.

• Graphics language is SVG-based

• cd:\Editors\OpenOffice\

Peter’s XML Editor

• Another XML tree editor

• I like the name

• www.iol.ie/~pxe/

• cd:\Editors\Peters\

TextPad

• A fairly-sophisticated programmer’s editor

• Used in aXtive Minds classes

• Can be configured and integrates well with external processors

• textpad.com

• cd:\Editors\TextPad\

XMLEditPro

• A validating XML editor that I’ve heard good reports about

• Tree view

• Highlights syntax in source view

• No timeout. Pay registration to drop message

• Source code available

• www.daveswebsite.com/

• cd:\Editors\XMLEditPro\

XoologyCoda

• A “syntax parsing” editor with built-in understanding of HTML, XHTML, and XML

• Able to use color changes to highlight errors

• www.xoology.com/concertox/xool/home/products/coda.html

• cd:\Editors\XoologyCoda\

Other Alternatives

Buzz XML Editor

• XLink support

• buzz.sourceforge.net/

Page 16 Setting up an XML Workstation

© 2002 The Sagebrush Group SagebrushGroup.com (408) 247-0454



Emile

• www.in-progress.com/emile/index

Oxygen XML Editor

• www.oxygenxml.com

Topology Collaborative Markup Editor

• Interface designed around the need of production personnel

• Easy to integrate parsers and other processors

• Requires Java 1.3 (at last check)

• www.topology.com

XED

• A text editor that suggests elements based on a DTD

• Doesn’t validate

• No syntax highlighting

• www.ltg.ed.ac.uk/~ht/xed.html

Xeddy

• A Java-base tree editor

• Includes DTD editor

• Context-sensitive insert element

• 30-day eval

• www.amaio.com/xeddy/

XML Edit

• Python-based

• galway.informatik.uni-kl.de/staff/riegel/projects/XMLEdit/XMLEdit.html

XML Edit

• Tree editor

• galway.informatik.uni-kl.de/staff/riegel/projects/XMLEdit/XMLEdit.html

XMLWriter

• Validates

• Includes XSLT and command-line support

• $50

• xmlwriter.net/

XSmiles

• A Java-based editor with SVG and FO support

• www.xsmiles.org/

Potential Problems

• You will never find one you truly like and go mad looking.

Setting up an XML Workstation Page 17

©2002 The Sagebrush Group SagebrushGroup.com (408) 247-0454



XSL Processing Tools

Role

• Transform XML documents into a different (target) markup langauge

• HTML

• XSL-Formatting Objects

• Other markup

• Generate Formatting Objects through other means

• Transform formatting objects into rendered output

• Author XSLT and/or FO code

• Individual tools may have a mixture of the above functions

XT

Role

• XSLT processor

Issues

Dependencies

• Requires Java engine

• Requires a SAX parser

Strengths

• Developed by James Clark as a proof of concept during the development of the XSLT

1.0 recommendation

• Simple

• Good learning tool

Weaknesses

• Incomplete

• Not optimized

Potential Problems

• Some XSLT features not implemented

Installation

Where to get it

• jclark.com

• cd:\XSL\XT\

• cd:\XTools\
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Provided version and files

• Unknown version

• cd:\XTools\

• xp.jar

• xt.bat

• xt.jar

• Version 20020426a

• cd:\XSL\Xtools\

• xt.jar

• XT.pdf

Installation Procedure

1. Copy xt.jar file to an appropriate directory

Configuration

1. Include xt.jar in classpath

Saxon

Role

• XSLT processor

Issues

Dependencies

• Requres a Java engine

• Version 7 requires Java 1.4

Alternatives (strengths/weaknesses)

• Operating environment

• Saxon (Java-based)

• InstantSaxon (Windows .exe)

• Versions

• 6.5.1 (very stable and complete)

• 6.5.2 (latest full release)

• 7.2 (development release)

Strengths

• Developed by Michael Kay

• Very complete implementation

• Direct PDF generation through FOP

Weaknesses

• Includes some extension functions that introduce side-effects in XSLT code, if used
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Installation

Where to get it

• saxon.sourceforge.net/ 

• cd:\XSL\Saxon\

• cd:\XTools\

Provided version and files

• Version 6.5.1

• cd:\XSL\Saxon\OldStuff\*.*

• cd:\XTools

• jsaxon.bat

• saxon-fop.jar

• saxon-jdom.jar

• saxon.exe

• saxon.html

• saxon.jar

•  Version 6.5.2

• cd:\XSL\Saxon\

• Instant-saxon6_5_2.zip

• saxon6_5_2.zip

• Version 7.2

• cd:\XSL\Saxon

• saxon7-2.zip

• cd:\XSL\Saxon\SaxonDownload.pdf

Installation Procedure

1. Copy desired files to appropriate directory

2. May wish to set up a separate Saxon directory for full set of files

Configuration

1. Set path and classpath, as appropriate

Testing

1. Invoking "saxon" (InstantSaxon) on the command line should return something like:
No source file name

SAXON 6.5.1 from Michael Kay

Usage: saxon [options] source-doc style-doc {param=value}...

...

2. Invoking "java com.icl.saxon.StyleSheet” on the command line should return something

like:
No source file name

SAXON 6.5.1 from Michael Kay

Usage:  java com.icl.saxon.StyleSheet [options] source-doc style-doc {param=value}...

...
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MSXSL

Role

• Small executable stub that runs XSLT engine included with MSXML4

• Used from the command line

Dependencies

• Requires MSXML 4

Installation

Where to get it

• microsoft.com

• cd:\XSL\MSXSL\

Provided version and files

• Version 4.0

• msxsl.exe

• msxsl.pdf

• MSXSLDownload.pdf

Installation Procedure

1. Copy executable to appropriate directory

Configuration

1. Set path, as appropriate

Testing

1. Invoking “msxsl” on the command line should return:

Microsoft (R) XSLT Processor Version 4.0

Usage: MSXSL source stylesheet [options] [param=value...] [xmlns:prefix=uri...]...

...

Other XSL Tools

Included on the CD

FOP

• The Apache project Formatting Objects processor

• cd:\XSL\FO\

• FOP.pdf

• fop-0.20.4-bin.tar.gz

• FOPDownload.pdf
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TreeViewer

• Translates an XML file into a tree that can be viewed in HTML browser

• Nice and readable

• cd:\XSL\TreeViewer\

• sample_output.html

• sample_input.xml

• tree-view.css

• tree-view.xsl

• TreeViewer.pdf

XPathVisualizer 

• Interactive tool that highlights nodes that match the XPath expression which has been

entered

• cd:\XSL\XPathVisualizer\

• XPathVisualizer.pdf

• xpathvisualiserseptember.zip

XSL Tester

• Visual XSL editor

• Supports dual panel editor and MSIE preview

• cd:\XSL\XSL Tester\

• XSLTester(latest).zip

• XSLTester.gif

• XSLTester.pdf

Mulberry Technologies XSLT Quick Reference

• cd:\XSL\XSLTquickref.pdf

Not included on the CD

FOA

• Formatting Object authoring

• Open source (from HP)

• foa.sourceforge.net/

TreeBeard

• Free XSLT editor

• treebeard.sourceforge.net/ 

Xalan

• The Apache project’s XSLT engine

XSLT Cookbook

• aspn.activestate.com/ASPN/Cookbook/XSLT/
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Parsers and Validators

Role

• Used to check XML documents for well-formedness

• Used to check XML documents for validation against a DTD

• Used to check XML documents for validation against a schema

• Used to load XML data into memory for processing

Issues

• Hard to find command line support

• Error messages can be very cryptic

Dependencies

• Some parsers require a Java engine

Alternatives

• Sun Project X, Crimson, Xerces, and JAXP Parsers

• MS XML 4.0 Parser

• Topologi Schematron Validator

Sun Project X Parser

Role

• Very early parser

• Used in training at Sun and HP

• Evolved into Crimson, Xerces, and JAXP parser packages

• Need for command line interfaces has been put on list of requirements for JAXP future

development

Issues

Dependencies

• Requires Java

Alternatives

Project X

• Command line execution

• Fairly good error messages

• Couldn’t find a distribution package

• No documentation

• Completeness (e.g., won’t flag elements that have been included in a content model but

haven’t been declared, unless the child elements exist in the instance).
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Crimson

• Handed over from Sun to Apache project

• Newer than Project X, but still superceded by Xerces and JAXP releases

• Couldn’t find any command line support

Xerces

• Maintained by the Apache project

• Very solid parser

• Couldn’t find any command line support

• See www.ecerami.com/xerces/ for a quickstart guide

JAXP

• Sun distribution

• Actively maintained with ongoing development

• Couldn’t find any command line support

Installation

Where to get it

• Project is Included in XTools distribution

• apache.org

• sun.com

• Other listed parsers in cd:\Parsers\

Provided version and files

ProjectX version

• cd:\XTools\

• parsevalid.bat

• parsewf.bat

• xml.jar

• xmlclass.jar

Crimson/JAXP

• crimson-1.1.3

• crimson-1.1.3-bin.zip

• Crimson.pdf

• CrimsonDist.pdf

Xerces

• CommandlLine(PERL).pdf

• (information that might be useful for creating command line interfaces)

• Xerces.pdf

• Xerces-J-bin.1.4.4.zip
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JAXP

• JavaWebServicesTutorial.pdf

• JAXP.pdf

• JAXPDownload.pdf

• JAXPInstall.pdf

• jwsdp-1_0_01-tutorial.zip

• jwsdp-1_0_01-windows-i586.exe

MSXML4 Parser

Role

• Provides validation to DTDs and XSchemas

• Very fast parser

• Error messages are fairly cryptic and hard to understand

Dependencies

• Requires Windows

Alternatives

Execute within Internet Explorer

• Requires the Microsoft IE Tools for Validating XML described above

• To use:

• Open the XML document in Internet Explorer

• Right-click

• Select the “Validate XML” option

Execute from command line

• Uses javascript and .bat files in XTools distribution

• validate.bat

• validate.js

• wellformed.bat

• wellformed.js

• To use:

• Enter “validate filename“ or “wellformed filename“ on command line

MS Command Line

• Scripts to do MSXML4 command line schema validation

• This has not been tested yet, but I expect to fold it into the XTools configuration

Installation

Where to get it

MSXML4 and Internet Explorer extensions

• Described above
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XTools

• Described above

MS Command Line

• www.schemavalid.com/utils/

• cd:\Parsers\MSCommandLine

Provided version and files

MSXML4 and Internet Explorer extensions

• Described above

XTools

• Described above

MS Command Line

• msxsd.txt

• msxsd.zip

• Demo\ (msxsd.zip unzipped)

• books.xml

• books.xsd

• msxsd.js

Toplogi Schematron Validator

Role

• Provides validation against DTDs, XSchemas, and Schematron Schemas

Issues

Dependencies

• Requires Java engine (1.3 or 1.4)

Strengths and Weaknesses

• Uses a two-panel GUI to specify XML document and schema

• Error messages can be very cryptic

Potential Problems

• Configuration can be tricky

Installation

Where to get it

• http://topologi.com

• cd:\Parsing\Topologi
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Provided version and files

• Version 2001.11.21

• TSV2001-11-21.zip

• Unzipped\

• Data.Cab

• Schematron Validator.msi

• setup.exe

• setup.ini

Installation Procedure

1. Execute cd:\Parsing\Topologi\Unzipped\setup.exe

2. Follow the onscreen prompts

What it puts on your computer

Files

• C:\Program Files\Topologi\Schematron Validator\*.*

Integrations

• None

Shortcuts

• Schematron Validator

Configuration

1. Run the Schematron Validator

2. Under Options > Configuration

a. Activate: “Validate with DTD”

b. Press “Save”

3. Under Options > W3C XML Schema

a. Activate "Validate with W3C XML Schema"

b. Press “Save”

4. Under Options > Locations

a. Set "Default Directory for XML Document"

b. Set "Default Directory for Schema Documents"

c. Press “Save”

Testing

1. Run the Schematron Validator

2. In the “XML Document” panel, browse to cd:\TestFiles

3. Browse or copy the selected directory to the “Schema” panel

a. Click on “Refresh”, if necessary to read the directory

4. Select “Bizcards.xml” in the “XML Document” panel

5. Select “bizcards.xsd” in the “Schema” panel

6. Press “Run” to validate.

7. Result should be: “XML file passed without errors.”
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Other DTD and Schema Tools

DTD Chart

• Renders DTD as tree diagram

• Can’t print or save image in freeware version

• http://www.intsysr.com/dtdchart.htm

DTD Generator

• Developed by Michael Kay

• Stand-alone utility to generate a DTD from an XML document

• saxon.sourceforge.net/dtdgen.html

• cd\XSL\Saxon\

• DTDGenerator.pdf

• dtdgen7-0.zip

DTD to Relax

• Converts DTD schema into RELAX module

• www.horobi.com/Projects/RELAX/Archive/DTD2RELAX.html

• cd:\DTDTools\DTD2Relax

• DTD2RELAX_1_1_1-bin.jar

• DTD2Relax.pdf

LiveDTD

• A very cool set of perl scripts that turn complex, multi-module DTDs into a set of

hyperliked HTML pages

• www.sagehill.net/livedtd/

• cd:\DTDTools\LiveDTD

• LiveDTD.pdf

• livedtd.zip

• xmlspec.zip (Demo files)

• cd:\DTDTools\Perl\ (a Perl distribution is needed for Live DTD)

• ActivePerl-5.6.1.633-MSWin32-x86.msi

• ActivePerlDistribution.pdf

• ActivePerlInstall.pdf

• ActivePerlReleaseNotes.pdf

• ActivePerlVersioning.pdf

• Win2kInstMsiW.exe

• Win9xMeInstMsiA.exe

LuMnX Tools

• An interesting set of DTD processing and conversion tools

• XSBrowser converts DTDs and XSchemas into human-readable documentation

• DTD2XS converts DTDs into XSchema files

• puvogel.informatik.med.uni-giessen.de/lumrix/

• cd:\DTDTools\LiMnX\

• LuMnXTools.pdf

• xsbrowser2.zip

• dtd2xs154.zip
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SchemaViewer

• cd:\Parsing\SchemaViewer\

• SchemaViewerSetup.jar

• SchemaViewer.pdf (bad pdf file)

• SchemaViewerSetup.zip

XSV

• Henry Thompson’s open-source schema validator

• cd:\Parsing\

• XSV.pdf (documentation only, code didn’t download)
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Other Tools

Adobe SVG Viewer

• An SVG viewer that integrates with web browsers

• Windows version only (must download other versions)

• www.adobe.com:80/svg/viewer/install/main.html

• cd:\SVG\AdobeSVGViewer\SVGView.exe

Batik

• An SVG toolkit from the Apache project

• cd:\SVG\Batik\

• Batik.pdf

• batik-1.1.1.zip

• batik-1.5beta4b.zip

• BatikDistribution.pdf

Dia

• A Visio clone that works with XML, EPS, and SVG files

• Dia\

• Dia.pdf

• dia-0.89pre1-setup.exe

DiffXML

• A SourceForge project

• version 0.9 (Alpha)

• cd\Diff\DiffXML\

• diffxml.pdf

• support_jars.tgz

HTML versions of the core XML specifications

• cd:\Specs\

• xml.html

• xpathTR.html

• xsltTR.html

• XSchemaReferences\

• w3.orgTRxmlschema-0.html

• w3.orgTRxmlschema-1.html

• w3.orgTRxmlschema-2.html

IRun

• Converts RTF to HTML or XML

• Can call .dll

• Version 1.11

• www.pilotltd.com/eng/irun/index.html

• See also: www.pilotltd.com/eng/index.html

• cd:\Conversion\IRun\

• irun111.zip

• IRun.pdf
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Microsoft XML Diff and Patch 1.0

• cd:\Diff\MSXMLDiff\

• MSXMLDiff.pdf

• MSXMLDiffLanguage.pdf

• XMLDiffPatch.exe

Netscape 8

• The most recent release has been reported to have good XML and XSLT support

• netscape.com

• cd:\Netscape8\

• NetscapeInstaller.pdf

• NetscapeInstallFAQ.pdf

• NetscapeInstallinstructions.pdf

• NSSetup.exe

• NSSetupB.exe

TClock

• Doesn’t have anything to do with XML, but is too cool not to pass on

• Customizes the display of the system clock on the taskbar

• Integral part of my personal Y2K compliance program: “Sun, 2002.12.08 15:28:05"

• Synchronizes with NTP servers

• member.nifty.ne.jp/kazubon/

• cd:\Misc\TClock\

• TC98228E.zip

• Unzipped\

• DLLSRC.zip

• EXESRC.zip

• NIKO.bmp

• SNTP.txt

• TCDLL.dll

• TClock.chm

• TClock.exe

• TClock.txt

• WIN98.bmp

WebDwarf

• HTML and SVG editor

• cd:\SVG\WebDwarf\

• imsdwarfv2.exe

• WebDwarf.pdf

• WebDwarfInstall.pdf

WinZip

• cd:\Misc\winzip81.exe
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WizZip

• A freeware zip utility

• Has an internal viewer, but won’t launch an external program

• cd:\Misc\WizZip\

• info-zip.pdf

• wiz502xN.exe

XML Standards Library 1.0

• Provides a help-based interface to some of the more common W3C XML specifications

• Creates a folder and set of icons under Programs

• cd:\Specs\basic0902.exe
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